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Siebel CRM Mobile for BlackBerry

Siebel CRM Mobile for BlackBerry® leverages the open and flexible development
platform provided by the BlackBerry® Mobile Data System (BlackBerry MDS) to
simplify integration with web services exposed by Oracle’s Siebel CRM.

Enterprises can develop mobile applications for their BlackBerry smartphones
using the native Ul of BlackBerry. This enables offline and online use of Siebel
CRM data. There is no synchronization of data initiated by the user, but data is
synchronized over the air provision. This provides a framework/tool to create
custom witeless application to be deployed over BlackBerry devices. Customers
need Siebel Wireless license if not already owned to use Siebel CRM Mobile for
BlackBerry. Providing wireless access to the latest CRM data available allows
stakeholders to deliver more effective customer service and more efficient
opportunity management in the field, which enables lower costs, increased

profitability and predictable revenue growth.

This whitepaper will demonstrate how to create a new WSDL for a Web Service
that will return contacts associated to a particular individual. This is just an
example of creating web setrvices. Same method can be used to create web services
to expose Setvice requests, Opportunities, Order Request etc depending on the
business process you deploy for mobile application.

The following steps are described:

O Create a new Integration Object

Limit the data returned by the Integration Object.

Update an existing Web Service provided by Siebel
Generate a new WSDL to be used by an external application
Create a new Project using MDS

(M) miy iy =



o/

1

2

O ">«

+(

Create a new project in Tools with the following properties:

Name RIM
Locked Checked
O ) C D +( I - )

The following steps will use a wizard to create a new Integration Object for
Contacts. The Integration Object will limit the data returned by only returning
contacts belonging to the user (My Contacts).

1. In Siebel Tools, from the menu bar, select File 2 New Object...

From the EALI tab, select Integration Object, then click the OK button

Populate the below fields:

Integration Object Builder )

Thig wizard will help you create a new Intearation Ohject.

Select the Praject thiz Integration Object will be part of from the list.

RiM =]

Specify the zource system of the new Integration Object. Select a
Business Service from the list.

4 Back et > | Cancel I
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Integration Object Builder | ﬂ
Select the zouce object for the new Integration Objact from the list,
Select the sowce roat for the new [ntegration Object from the list,
Contact El
Ertes a name fior the new Integration Dbject. Thes name must be
urique amang al Intagration Dbgects in all Pioects.
]HIM Contacts Only
o
o Back ext > Cancsl |
Integration Object Builder - Choose Integration Components il
Select the integration components that you would like to activate for this Integration
Object by checking the appropriste items.
BN orac
- [ Contact_Account
& [ Contact_action
-] Contact_Business Address
[ Contact_Personal Address
[ Contact_Affinity Graup
- [] Contact_Contact Mote
- [ Contact_DeDuplication - 554 Contact Key
[ Contact_Communication Address
[ Contact_Altemnate Phone
- [] Cortact_Sales Assessment
-] Contact_FIMS eBanking Asset Account
LI [ Cortact_Brick
| oy I o BTN | RSy SO O [y
N I 2
Ihclude component O Iagnare component
< Back I Next » I Cancel

Select the newly create Integration Object and set/confirm the below
properties:

For the Integration Obiject:

Project RIM

Base Object Type Siebel Business Object
External Name Contact

XML Tag ListOfContactRIM

For the Integration Object-> Integration Component:




External Name Context | Contact
Name Contact
External Contact Contact
Cardinality Zero or Motre
XML Tag Contact

4. For the Integration Object = Integration Object User Prop:

AllLangIndependentVals | N
ViewMode Sales Rep

NOTE: Disable the remaining propetties

5. Activate only the data fields desired to be returned by the Integration
Object

6. Confirm/Set the User Key to reflect the below image:

:| Integration Component Key Fiel... |

Integration Companent Keys
| i | Marne | Changed | Key Sequence Murnber | Key Type
ﬂ & W7 tiizard-Generated User Key:1 v 1 User Key

Integration Cormponent Key Fields

| W | Marne Changed | Field Mame | Sequence
v 1d

) C (@ * C (3 ( C 3 (

Simply leverage the existing Business Service and change a method’s input
parametet.

1. Search for the Business Service, Siebel Contact
. Change the Project name to “RIM”

3. From the Business Service - Business Service Method select Query
By Example

4. Expand the Business Service Method Arg object and select Siebel
Message

5. Change the Integration Object property to the newly create Integration
Object “RIM Contacts Only”



:| Business Services

Export Import |

Display Mame - String Reference | |

| ‘! | Mame Changed | Praoject | Cache Class Display Hame
SEL_SIEEEL_COMTACT-1004224344-0

,T s v RIM CESEAIDataSyncSer vice Siebel Contact

6. Select the Business Service User Prop object

Note: If you don’t see this object, go to View = Options > Object
Explorer and activate the object

Development Tools Dptions LI

General | Language Settings I Check In/Dut | List Wiews | Scripting I
“Web Template Editor | Debug | Wisualization Object Explorer I Databaze

Select the objects you want to wark with

Obiject Explorer Hierarchy:

- [] Aszignment Attibute ;I
- [] Assigrment Criteria
Bitrnap Categany J
Business Component
Buginess Object
Business Service
-] Business Service Browser Script
[ Business Service Locale
Business Service Method
Buziness Service Server Script
Biusiness Service Subsystem

Iser Prop:
=l

1 Clase

0K | Cancel

7. Change Internal Integration Object propetty to “RIM Contacts Only”

:l Business Service User Prop List |

Export | Irmport
| h | Marne Changed | Project Cache Class | Display Mame
ﬂ # Siebel Contact v RIM CSSEAIDataSyncService Siebel Contact

er Props

Changed | Yalue | Inactive |C0mmenls

Marne
pplication Services Interface ¥
J A Internal Integration Object v RIM Contacts Activities

-C . (C +(
1. From the menu bar, select Tools - Compile Projects...

NOTE: Compile to both Setver and Local SRF
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4, Services =10 x|

Eile  Action View Help

e El = BN e e T
% Services (Local)

%, Services (Local)

Siebel Server [ENT_APPSRYR] Mame / I Description I Skatus I Starkbup Type | Log On As ﬁ
%&hel Gateway Mame Server  Siebel Gat...  Started Manual adrmin
Stop the service %Siebel ICHM Manual Local System
Restart the service %Siehel Management Agent ip... SiebelMa... Manual admin
%EIEhd Management Server (p... Siebel Ma... Manual Aadmin
%Siebel QuickStart Service Disabled Local System
%Siehel RTD Server IManual Local System
5 ¢ [ENT_APPSRUR] Started  Manual \admin
%Smart Card Manages ... Manual Local Service

) .C C ¢ -(

Since we are using an existing Web Service/ASI, we only need to update the
header information for the web service.

—_

Login into Siebel as an Administrator
Navigate to Site Map > Administration - Web Services = Inbound
Web Services

M

Search for “Siebel Contact”

Confirm/Set the Status to “Active”

In the Service Port Applet, confirm the Transport is “HTTP”

The Address must reflect your server. Include the login parameters in the
address. Below is a sample address:
http://192.168.15.2/eai_enu/start.swe?SWEExtSource=WebService&SW

SIS

EExtCmd=Execute&UserName=TSMYTHE&Password=TSMYTHE

7. In the Operations applet, confirm the SiebelContactQueryByExample
operation is available and the Authentication Type is “None”

8. Generate 2 new WSDL

9. Send a SOAP message with the LastName tag set to “*”



MDS Studio uses web services to send and receive data and uses screens to display
this data. To get started you will need a WSDL. In our example, I will be using a
WSDL generated from Siebel. Once you have the WSDL file, you can use wizards
provided by the MDS application to help you get started. The Quick Start
Approach wizard will generate screens, messages and the data components
required to post a SOAP message. The Bottom Up Approach will only build the
messages and the data components. I recommend starting with the Quick Start
wizard to see what gets built and how those objects work with one another. You
still have the flexibility to alter the generated objects to meet your needs. Once you
are comfortable with the objects, you will notice that you will only need to use the

Bottom Up wizard. This way you can create your own user interface experience.

CE*CCH -3 -C
As of MDS Studio Version 1.1.1.35 a small modification must be made to the
WSDL file generated by Siebel prior to importing the WSDL file to MDS Studio
application. The XML escape character, &quot;, will need to be added to each
SOAP action.

1. Open the WSDL file with your choice of text editors.
2. Locate the following text: SoapAction

3. Insert the following text as shown below in the before and after example:

Before:

soapAction=""document/http://siebel .com/asi/:SiebelAccoun
tQueryByld"

Alfter:

soapAction=""&quot;document/http://siebel .c
om/asi/:SiebelAccountQueryByld&quot;"™

1. Repeat this process for each soapAction
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1. From the MDS Studio Application, select File > New Project...
Accept the default, Quick Start Approach Wizard and select Next >
button

3. Accept the default, WebService Connector Plugin and select the
Next > button

4. Locate the WSDL file that you would like to use. You may have to use
their Web Service Locator tool. Simply select the Local File System
tab and locate the WSDL file.

5. A binding window will appear. Select the operation you would like to
use for your project.

F Create New Project

Ouick Start Approach

Select the operations to bind to wour application

Binding Information

=[] I= file: /D faccount. wsd| .
+-[Ja SiebelaccountInsert

L ¥-<icbelAccountQueryById

Oe* siebelaccountpdate

Oe+ siebelaccountCueryByExample

Oe+ SiebelaccountInsertorpdate —

Oe+ siebelaccountSynchronize

Oe+ siebelaccountDelete

B0
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| Mext = | Cancel

6. Enter a name for your project and select the Finish button.
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Data definitions describe the makeup of the data. This would include
strings or integers and it can also reference other data definitions.



= Account Id Test
- Application
-7 Data
--[FZ Definitions
+-[AF Built-in
-3 aAccount< Data definition
Itl SocountId o oskring
Accounkskatus @ skring
Alias : skring
ListCfBusinessaddress | Businessaddress[]
LiskioFRelated5alesRep | Related3alesRep[]

LiskoFRelatedContact ; RelatedContact] —
ListoFRelatedOrganization | RelatedOrganizatic Reference to another data definition

LiskoFCreditProfile : CreditProfile[]
LiskoFRelatedIndustry ;. RelatedInduskry[]
operation : skring

inessaddres4
AddressId ¢ skring
AddressIntegrationId ; skring
ity @ skring

Counkry - skring

Counky | skring

PostalCode @ skring

Province @ skring

State : string

Strestfddress | string
Stresttddress? ¢ skring
IsPrimaryMyia § skring
operation : skring

BeGe66666
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Messages represent the data that is either sent to Siebel or data that is being
returned. The messages generated by the wizard are driven by the wsdl The fields
for the message are made up of either a data type such as a string or reference to a
data definition. When creating an outbound message that uses a data definition, the
definition must be populated first, then assigned to the message. A sample snippet
is posted in the Sample Code section.

20
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o Mavigator X =
+-fi& nccount Id Test
= [/F Siebel Cantacts 3
—=-§3 Application
- Diata
= Cefinitions
+ @ Built-in
ﬁ &ckion
(3 action1
(3 actionz
ﬁ &ctionInsert
ﬁ Zonktackl
ﬁ Contack 2«
EI CellularPhone : string
EI Ernaildddress @ string
EI Firsthame : string
EI LastMame : string

[ [ e e B

EI Rowld @ skring
E] WorkPhone : string Both the Input and the Output use the

+ P Collections —| Contact2 data definition to describe what
+-F® Glabals the data fields are for the messace

+ Enumerations
@ Data Model Yiew
—| 7%} Messages
—-Emp SiebelContactQueryByExample_Inpuk
d;| SiebelMessage | Contact?[ J¢é———
—-Ep SiebelContactQueryByExample_Cukpuk
d;| SiebelMessane | ConktactZ[J<

SiebelContackQueryBy
+-Ep SlebeICDntactQueryById _Cukput

Here is a detailed representation of the message’s input fields. To see
these details, simply double-click on the message and select the Fields

tab.
Basic Properties | Fields
2=
Marne | Tvpe Daka Mapping | Array | Defaulk Yalue |

SiebelContactQueryByExample_Input Message

??
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Before you post the message to the external system, the message fields must be
populated. Remember, how the fields are determined are driven by the WSDL.
The message illustrated below uses a field that is an array. Therefore, I must create
my data definition, assign a field a value then add that definition to a global
variable that is used by the message. The below example would be code used to
populate the SiebelContactQueryByExample_Input message.

Jaas oy Create a new local object based on the data
lwar sContact = Contacti.createl):; definid
efinition.
zgtontact.Lastlame = "%7; . .
. — new Arrayi); Set search specification to return all contacts.
. .
4 _ (sContact) : 1 Set the. global array using the Contact2 data
SdiebelContactQueryByExample Tnput.sendl):; definition.

GetMySiebelContacts Script

- ) «

The screen represents the user interface. It is here where the user will call the
external application to retrieve data. A screen will also be used to display the result
message from the external application. Below is an example of calling the script
from the previous example. The script will build the message and submit the

request to the external application.

Siebel Sales Application EE F_mmul

7
>
n

___________________________________________________ |
B Properties
Property | Yalug |
Capkion =
Image
Mame L4 bknGo3
on Click, SHGetMySichelContacts
on Init "
Placement .@ (1,0)
Skyle B ListData
Wisibility e brue
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Displaying the data returned from the web service is a separate process. A separate
message will redirect the data to a script. Double-click a message that contains a
suffix of _Output. Click. In the diagram below, the

SiebelContactQueryByExample_Output_onMsgArrive will be called.

Message Type: Inbound (server- =device)

Basic Properties | Fields | Alerts

Mame: |Siel:uEICnntactQueryEiyExample_output ﬁ Parent:

Secure Scripk

[ Mew... | Cpen
|Fa|SE j SiebelContactQueryEvExample Oukpuk_onfMsghrrive

When the message arrives, the data will be in a dataset defined by the message.
Double-click a message that contains a suffix of _Output and click the Fields tab.
In the diagram below, the data returned by the web service will be in the dataset
gContact2Array. This is a previously defined global vatiable that is an atray of type
Contact2.

Message Type: Inbound (server- =device)

Basic Properties | Fields | Alerts

2|=

Mame Type Drata Mapping Array Default Yalue
SiebelMessane Conkackz gConkactZarray[] krue

The script, SiebelContactQueryByExample_Output_onMsgArrive, is called when the
message arrives. The script simply opens the screen that will display the data.

Javascripk:
lsor¥MyContacts List.display():

The screen will contain an object that will be used to display the data. The example
below uses a table to reference the global variable and uses its columns to display
each data element.




Contacts SE Fommm B B properties 58 B = =8
My Contact=
- Properk:y | Yalue L
Ewven Row Style
; - =1 Header Style Hf parkiarayBackground
Last Name e A R I i Initial Value 1= @qContact s ayi]
HE ' ' i Mapping % lv_Contactz _SiebelMessage
: . . N MName L& tablefrraysiebelMessage
£ O N | | Odd Row Style B2 ListData
"""""""""""""""""""""""" ' on Change I
on Init o
Placement
Shows Gridline % False
Shows Header [ brue
Showe Raowe Selector M6 true
Skyle
Visibility [ brue

?4



Then end result of seeing a list of all contacts that belong to you may resemble the
following diagram:

BlackBerry

Contacts

My Contacts

bLast Name First Name
Accinni Kathy
Albert Frank
Anderson Trevaor
Anniston Jessica
Armstrong Joseph
Arnhold Amber
Bartolo Anthany
lac Madison
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Retrieving data from a table’s column

This is very handy when you want display a list of all you contacts, but not bring
back all their details. You can display all your contacts in a table and hide the
column that contains the Siebel row id. Then when you are ready to get the
contact’s detail information, you can use the row id to make a second web service
call to retrieve the contact’s detail.

Format:
variable = screen.tablename.columniscreen.tablename.selectedRowIndex]

Example:
gContactRowld =
scrMyContacts.tblContacts.Rowld[scrMyContacts.tblContacts.selectedRowIndex];

How to get the value from a dropdown list

Format:
variable = screen.control.value[screen.control.selected]

Example:
strActivityT'ype = scrfSRActivity_New.txtType.v

You have learned how to create a new WSDL for a Web Service that will return
contacts associated to a particular individual. Go to this website for more

information: www.blackberry.com/go/oracledev. Once the WSDL is ready, you

can use it for exposing contacts data on the blackberry using MDS. Similarly you
can bring other data associated with Contacts and/or other objects. To learn
more, please call your Oracle representative at: (800) 273-9813 or visit:
www.oracle.com/applications/crm/siebel.
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